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Introduction

Who Should Use This Guide
Who Should Use This Guide Intro

This guide describes the process of finding and removing duplicate records. 

This book will be useful primarily to people whose titles or job descriptions match 
one of the following: 

Database 
Administrators

Persons who administer the database system, including data 
loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 
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How This Guide Is Organized
How This Guide Is Organized Intro

This guide provides information necessary to install, configure, and use Siebel Data 
Quality Matching, MidMarket Edition and Siebel Connector for Firstlogic Libraries, 
MidMarket Edition. These two products provide data matching and data cleansing 
for the Siebel eBusiness Applications. 

NOTE: All Siebel MidMarket product names include the phrase MidMarket Edition 
to distinguish this product from other Siebel eBusiness Applications. However, in 
the interest of brevity, after the first mention of a MidMarket product in this 
document, the product name will be given in abbreviated form. For example, after 
Siebel Call Center, MidMarket Edition, has been mentioned once, it will be referred 
to simply as Siebel Call Center. Such reference to a product using an abbreviated 
form should be understood as a specific reference to the associated Siebel 
MidMarket Edition product, and not any other Siebel Systems offering. When 
contacting Siebel Systems for technical support, sales, or other issues, note the full 
name of the product to ensure its proper identification and handling.
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Additional Documentation
Additional Documentation Intro

The product documentation set for Siebel eBusiness Applications is provided on the 
Siebel Bookshelf CD-ROM. For general information about Siebel product 
documentation, see the Siebel Bookshelf home page and Documentation Roadmap, 
MidMarket Edition.

Siebel Systems, Inc., reserves the right to modify the documentation for Siebel 
eBusiness Applications at any time. For updates to Siebel documentation, go to the 
SupportWeb site (http://ebusiness.siebel.com/supportweb/). 

If you want to order additional Siebel documentation and copies of the Siebel 
Bookshelf, go to Books Online at http://ebusiness.siebel.com/booksonline.

To access both SupportWeb and Books Online, you will need to provide the user 
name and password you received from Siebel Support Services 
(support@siebel.com).
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Introduction

What’s New in This Release
What’s New in This Release Intro

For a list of features new in this release, see the “What’s New” books included on 
the Siebel Bookshelf. Your Siebel implementation may not have all the features 
described in those guides, depending on which software modules you have 
purchased.

It is also strongly recommended that you read Fundamentals, MidMarket Edition so 
that you can make optimal use of your Siebel application, especially if you are new 
to Siebel software.

Contacting Siebel Technical Support Intro

Do you know how to access Siebel Technical Support? It is crucial that you 
understand the requirements for getting support before you encounter technical 
issues that require Siebel Technical Support’s assistance. This will facilitate smooth 
and timely resolution of your issues. If you have questions, please don’t hesitate to 
contact us.

To maximize your knowledge of Siebel products and your return on investment:

■ You must attend Siebel University training to become a designated contact. 

■ Your Siebel-trained designated contacts provide technical support to your users. 
Siebel Technical Support provides support directly to your designated contacts 
only. 

To provide efficient, timely support and access to the Technical Support knowledge 
base:

■ Siebel Technical Support is primarily Web-based; it can be accessed through 
Siebel SupportWeb (http://ebusiness.siebel.com/supportweb/). Please submit 
new service requests to us through SupportWeb, where you can also search the 
knowledge base for solutions.

■ Designated contacts receive read/write access to Siebel SupportWeb. All other 
project team members at your company receive read-only accounts so that they 
can access the knowledge base.
Version 7.0, Rev. A Siebel Data Quality Administration Guide MidMarket Edition Intro-5
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Introduction

Contacting Siebel Technical Support
To register for Siebel training, access http://siebeluniversity.siebel.com/edportal/
jsp/index.jsp and choose Implementation Team Training.

Please submit your technical issues and updates to Siebel SupportWeb 
(http://ebusiness.siebel.com/supportweb/). If you do not have a SupportWeb 
account, or if you have a question, please contact us at support@siebel.com or call 
your local Siebel Support Center:

■ North America: +1 800 214 0400 or +1 650 341 0700

■ Brazil (São Paulo): +55 11 3444 0800 

■ UK (London): +44 (0) 1784 494949

■ Germany (Munich): +49 89 957 18 400

■ France (Paris): +44 1784 494949

■ Ireland (Galway): +44 1784 494949

■ Japan (Tokyo): 0120 606 750 (toll-free, Japan domestic only), 
+81 3 5464 7948 (outside of Japan)

■ Singapore: +65 6 212 9266 

Outside of local support center hours, Gold and Rollout Support Option customers 
can call +1 800 214 0400 or +1 650 341 0700.

We appreciate your business and look forward to working with you.
Intro-6 Siebel Data Quality Administration Guide MidMarket Edition Version 7.0, Rev. A

http://siebeluniversity.siebel.com/edportal/jsp/index.jsp
http://siebeluniversity.siebel.com/edportal/jsp/index.jsp
http://ebusiness.siebel.com/supportweb/


Introduction

Siebel Systems Welcomes Your Comments
Siebel Systems Welcomes Your Comments Intro

To help us improve our products, we want to know about any corrections or 
clarifications to this guide that you would find useful. Please include in your 
message:

■ The title and version of the guide (very important)

■ The name and version number of the Siebel application you are using

■ Your name, job title or functional area, company name, phone number, and 
email address

Contact us through regular mail or email at:

Siebel Systems, Inc.
Technical Publications Department
2207 Bridgepointe Parkway
San Mateo, CA 94404-5009

doc@siebel.com 

We appreciate your feedback.
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Siebel Data Quality Overview

About Siebel Data Quality
About Siebel Data Quality 1

The name and address data stored in Account, Contact, and Prospect records in 
Siebel eBusiness Applications represents your interaction with existing and 
potential customers. Because of the importance of this data, maintaining its 
integrity is critical.

Siebel Data Quality helps enterprises standardize their Account, Contact, and 
Prospect data in the following ways:

■ Data matching (deduplication). Identifies possible matches for Account, Contact, 
and Prospect records, based on user-defined criteria. Duplicate records can be 
merged into a single record.

This book generally uses the term data matching for this functionality. The term 
deduplication is also used. Typically, it is used in configuration files, user 
properties, and so on.

■ Data cleansing. Data cleansing resolves the matches identified by data matching. 
Data cleansing consists of:

■ Address correction. Street address, city, state, and postal code information is 
stored in a uniform and consistent format, as mandated by United States 
postal requirements. 

For recognized U.S. addresses it provides ZIP+4 data correction and stores 
the data in standard U.S. Postal Service format.

■ Standardization. Account, Contact, and Prospect information is stored in a 
uniform and consistent format.

■ Capitalization. Account, Contact, and Prospect names are converted to mixed 
case. And address fields are converted to mixed case, all lowercase, or all 
uppercase.
1-2 Siebel Data Quality Administration Guide MidMarket Edition Version 7.0, Rev. A



Siebel Data Quality Overview

About Siebel Data Quality
Data matching and data cleansing functionality are provided by two third-party 
solutions, NAME3 software from SearchSoftware America, Inc. and Firstlogic 
software using the Siebel Connector for Firstlogic Libraries. Data cleansing 
functionality is provided using the Siebel Connector for Firstlogic Libraries. The 
following sections contain an overview of these products. The rest of the chapters 
in this book contain more detailed information about installing and using them.

NOTE: You can enable matching using Siebel Data Quality Matching and cleansing 
using Siebel Connector for Firstlogic Libraries. You cannot, however, enable 
matching with Siebel Data Quality Matching and Siebel Connector for Firstlogic 
Libraries simultaneously.

Data cleansing is also provided by third-party integration solutions validated by 
Siebel Systems’ Technical Alliances program. For information about third-party 
solutions, see the Alliances page at www.siebel.com.
Version 7.0, Rev. A Siebel Data Quality Administration Guide MidMarket Edition 1-3
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About Siebel Data Quality
Siebel Data Quality Matching 1

Siebel Data Quality Matching provides data matching functionality for data stored 
in the Account, Contact, and Prospect tables within Siebel eBusiness Applications. 
It allows administrators to specify matching fields in Siebel Tools and identify the 
records that match the criteria. It also provides the ability to merge duplicate records 
into a single record. Siebel Data Quality Matching works across the languages and 
platforms supported by Siebel eBusiness Applications.

Siebel Data Quality Matching Functionality
Siebel Data Quality Matching provides the following functionality:

■ Key generation. Siebel Data Quality Matching uses multiple keys in order to detect 
duplicate records. Keys are generated based on a person’s name (First Name, 
Middle Name, Last Name) for prospects and contacts, or account name for 
accounts.

■ Search. The search functionality generates ranges of possible keys for Person 
Name, Company Name, or Address fields.

■ Match. Match scores are based on similarities between the specified match 
fields. Different combinations of fields representing Person Name, Company 
Name, Address Line1, Address Line2, and ZIP Code are used for matching 
comparison.

The match process is twofold: 

■ First, Siebel Data Quality Matching identifies candidate matches by locating 
those records whose corresponding keys fall within a range. Like the keys, 
these ranges are based on a person’s name (First Name, Middle Name, Last 
Name) for prospects and contacts, and account name for accounts. 

■ Next, a match score is computed for each candidate record. Candidates with 
scores that exceed the specified threshold are identified as matches. 
1-4 Siebel Data Quality Administration Guide MidMarket Edition Version 7.0, Rev. A
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About Siebel Data Quality
Siebel Connector for Firstlogic Libraries 1

Siebel Connector for Firstlogic Libraries is an out-of-the-box connector to the ACE, 
TrueName, and Match software available from Firstlogic Corporation. Siebel 
Connector for Firstlogic Libraries provides access to data cleansing and data 
matching software for addresses in the United States. Customers who choose to use 
Siebel Connector for Firstlogic Libraries must buy the software separately from 
Firstlogic Corporation.

NOTE: The Siebel Connector to Firstlogic Libraries supports Firstlogic's U.S. address 
product, Firstlogic ACE. Firstlogic Corporation also provides validated integration 
between its international address correction engine (IACE) and Siebel applications. 
For more information, please contact Firstlogic at www.firstlogic.com.

This guide describes the functionality provided through Siebel Connector for 
Firstlogic Libraries. More detailed information about the Firstlogic product is 
provided in the third-party section of the Siebel Bookshelf.
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About Siebel Data Quality
Data Cleansing Functionality
Data cleansing can fix inaccurate and inconsistent data for new or modified 
Account, Contact, and Prospect records, as described in Table 1-1.

Table 1-1. Data Cleansing Operations 

Type of Correction Comments

Address correction The following fields in an account address may be modified:

■ Street Address

■ City

■ State

■ ZIP Code

Note that the Country field is not subject to data cleansing.

For recognized U.S. addresses, the application reconciles 
the Address fields with their corresponding ZIP + 4 postal 
codes. It then stores these fields in standard U.S. Postal 
Service format. For example, 100 South Main Street, San 
Mateo, CA 94401 becomes 100 S. Main St., San Mateo, CA 
94401-3256.

Standardization Standardization operates on different fields for Account, 
Contact, and Prospect records.

■ Account records. Standardization works on the 
Account Name and Site fields for Account records.

■ Contact and Prospect records. Standardization 
operates on First Name, Middle Name, Last Name, and 
Job Title for these records.

Examples of standardization are as follows:

■ Siebel Systems, Incorporated becomes Siebel Systems, 
Inc.

■ IBM Corporation becomes IBM Corp.

Capitalization The application stores and presents all Name and Job Title 
fields in mixed case for Account, Contact, and Prospect 
records. As an example, ACCOUNT REPRESENTATIVE will 
be changed to Account Representative and john smith will 
be changed to John Smith.
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About Siebel Data Quality
Matching Functionality
Unlike Siebel Data Quality Matching, the matching functionality of Siebel 
Connector for Firstlogic Libraries uses a single-key approach.

■ Key Generation. One key—also called a dedup token—is generated per record. 
Although configurable, the dedup token is based on the Last Name, Account 
Name, and Address Postal Code fields for contacts and prospects, or the Account 
Name, Postal Code, and Street Address for accounts. Because the dedup token is 
generated during data cleansing, there is no need to run an explicit key-
generation process.

■ Match. Candidate matches are found by searching for records with identical 
dedup tokens and computing a score for each candidate. The score is based on 
similarity between match fields. Records with scores higher than the defined 
threshold are identified as a match. 
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1-8 Siebel Data Quality Administration Guide MidMarket Edition Version 7.0, Rev. A



Siebel Data Quality Matching 2
About Siebel Data Quality Matching . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2

About Installing Siebel Data Quality Matching  . . . . . . . . . . . . . . . . . . . 2-3
Version 7.0, Rev. A Siebel Data Quality Administration Guide MidMarket Edition 2-1
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About Siebel Data Quality Matching
About Siebel Data Quality Matching 2

Siebel Data Quality Matching is provided by NAME3 software from SearchSoftware 
America, Inc. SSA-NAME3 is included on the Siebel eBusiness Applications CD-
ROM and is integrated with Siebel eBusiness Applications. Customers who purchase 
Siebel Data Quality Matching receive the SSA software and the integration from 
Siebel eBusiness Applications to SSA-Name3. No additional software needs to be 
purchased or deployed to run Siebel Data Quality Matching.

NOTE: For detailed information on SSA-NAME3, please refer to the SSA-NAME3 
documentation that is included in the third-party section on the Siebel Bookshelf.
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About Installing Siebel Data Quality Matching 2

During the installation process for Siebel Server, choose SSA in the Siebel Software 
Configuration Utility - Siebel Server Configuration screen, as shown in Figure 2-1, 
to enable Siebel Data Quality Matching. Selecting SSA enables matching for both 
Siebel Web Client and Siebel Dedicated Web Client.

Figure 2-1. Selecting SSA to Install Siebel Data Quality Matching
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If you plan to run Siebel Data Quality Matching in batch mode, enable the Data 
Quality component group in the configuration screen as shown in Figure 2-2. You 
can also do this later from the Server Administration screen within the application.

The Data Quality Matching files and folders shown in Table 2-1 are installed.

Figure 2-2. Enabling the Data Quality Component

Table 2-1. Siebel Data Quality Matching Files and Folders

File or Folder Description

<siebel_root>\bin\
<language>\n3sgsb.dll

NT version.

A DLL (dll) or shared object (so) containing the routines 
linked with the SSA-NAME3 (Siebel Data Quality Matching) 
interface.

Note that you must replace <language> with the appropriate 
language code, such as ENU for American English.
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Siebel Connector for Firstlogic Libraries 3

As discussed in “Siebel Connector for Firstlogic Libraries” on page 1-5, you need to 
purchase Siebel Connector for Firstlogic Libraries from Firstlogic Corporation 
(www.firstlogic.com). For information about which version of Siebel Connector for 
Firstlogic Libraries to install, see the system requirements and supported platforms 
documentation for your Siebel eBusiness Applications.

It is recommended that you install the Firstlogic software before installing Siebel 
eBusiness Applications. 

■ To implement data cleansing in the Siebel eBusiness Applications environment, 
you need to install the ACE Library and the TrueName Library.

■ To implement the Siebel Connector for Firstlogic Libraries data matching, install 
the Match Library. ACE, TrueName, and Match Libraries are sold by Firstlogic 
Corporation and must be purchased separately.

The default installation path for Firstlogic programs is C:\PW. Please refer to the 
Firstlogic documentation provided with the product for instructions on how to 
install these products.

Installing Dictionary Files on the Network 3

You have the option of placing your Firstlogic dictionary files in a network directory 
instead of placing separate copies of the dictionary files on each user’s computer.

If you place the dictionary files in a network directory, you must explicitly identify 
the location of the dictionary files in the aceaux.cfg file. For example, if your data 
dictionaries are installed in the directory \acme\common\Data_Quality\PW\dirs, 
then the related entries in aceaux.cfg should be: 

Table 3-1. Sample ACEAUX.CFG File Entries

ACE_Dir_City \\acme\common\Data_Quality\PW\dirs\city07.dir

ACE_Dir_ZCF \\acme\common\Data_Quality\PW\dirs\zcf07.dir

ACE_Dir_ZIP4_1 \\acme\common\Data_Quality\PW\dirs\dirs\zip4us.dir
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Siebel Installation Options 3

You must select very specific options while installing Siebel eBusiness Applications 
that allow the Siebel installer to make modifications to the Firstlogic configuration 
files. Make the following choices during the Siebel eBusiness Applications 
installation process:

■ Setup Type. Select the Custom installation option from the Setup Type dialog box.

■ Configuration files. Select First Logic Configuration Files as one of the Siebel 
Server Files components, as shown in Figure 3-1. 

■ Data-matching software. Select software for data matching. See Figure 2-1 on 
page 2-3 for a sample data-matching software selection dialog box.

■ Root directory. Identify the Firstlogic root directory when you are asked in the 
Siebel Software Configuration Utility - Siebel Server Configuration dialog box. 
The suggested path is <drive>:\pw, such as c:\pw on Windows NT.

Figure 3-1. Selecting Firstlogic Configuration Files
Version 7.0, Rev. A Siebel Data Quality Administration Guide MidMarket Edition 3-3



Siebel Connector for Firstlogic Libraries

Siebel Connector for Firstlogic Libraries
■ Batch mode. If you plan to run Siebel Connector for Firstlogic Libraries in batch 
mode, you need to enable the Data Quality component in the configuration 
screen, as shown in Figure 3-2, or later in the process from the Server 
Administration screen from within the application. 

Figure 3-2. Enabling the Data Quality Component
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Configuration Files 3

If the Siebel Connector for Firstlogic Libraries programs are installed after installing 
Siebel eBusiness Applications, or if the Siebel installer does not locate their 
installation paths, verify that the Firstlogic configuration parameters match those in 
the tables below.

All the configuration files—including ACEAUX.CFG, TNAUX.CFG, ACE.CFG, 
TN.CFG, FIRM.CFG, and FIRMINDV.CFG—can be found in 
<siebel_root>\idcentric\<language>.

NOTE: Substitute a valid language code, such as ENU for American English, for 
<language>.

The following tables are based on the assumption that your system is running 
Windows NT and the Firstlogic files reside in the c:\PW directory. You will need to 
modify the path in the Change To column if the Firstlogic files are stored in a 
different location.

ACEAUX.CFG 3

Change the following entries in ACEAUX.CFG. Be sure to verify that you are using 
the most recent version of the Firstlogic files, including the Postal file for 
ACE_Dir_City.

Entry Change From Change To

ACE_Form_3553 \acelib\ace3553.frm c:\pw\acelib\ace3553.frm

ACE_Form_NDI \acelib\acendi.frm c:\pw\acelib\acendi.frm

ACE_Dir_City \dirs\city06.dir c:\pw\dirs\city07.dir

ACE_Dir_REVZIP4 \dirs\revzip4.dir c:\pw\dirs\revzip4.dir

ACE_Dir_ZCF \dirs\zcf06.dir c:\pw\dirs\zcf07.dir

ACE_Dir_ZIP4_1 \dirs\zip4us.dir c:\pw\dirs\zip4us.dir

ACE_Dct_Address_Line \acelib\addrln.dct c:\pw\acelib\addrln.dct

ACE_Dct_Last_Line \acelib\lastln.dct c:\pw\acelib\lastln.dct

ACE_Dct_Capitalization \acelib\pwcas.dct c:\pw\acelib\pwcas.dct

ACE_Dct_Firm_Line \acelib\firmln.dct c:\pw\acelib\firmln.dct
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TNAUX.CFG 3

Change the following entries in TNAUX.CFG.

Change the values in the following .cfg files (ACE.CFG, TN.CFG, FIRM.CFG, and 
FIRMINDV.CFG) to point to the location where your Siebel Server files are installed. 

The following tables are based on the assumption that the Siebel Server files are in 
the c:\Siebel directory. You will need to modify the path in the Change To column 
if the Siebel Server files are in a different location.

NOTE: Change <language> to a valid language code, such as ENU for American 
English.

ACE.CFG 3

Change the following entries in ACE.CFG.

Entry Change From Change To

TN_Dct_Parsing \nlib\parsing.dct c:\pw\tnlib\parsing.dct

TN_Dct_Capitalization1 \tnlib\pwcap.dct c:\pw\tnlib\pwcap.dct

TN_Keyfile \tnlib\tnlib.key c:\pw\tnlib\tnlib.key

TN_Rule_File_Firm \tnlib\fprules.gcf c:\pw\tnlib\fprules.gcf

TN_Rule_File_Multiline \tnlib\mlrules.gcf c:\pw\tnlib\mlrules.gcf

Entry Change To

ACE_Auxiliary_Config_File C:\Siebel\IdCentric\<language>\aceaux.cfg

ACE_Input_Fields_Config_File C:\Siebel\IdCentric\<language>\aceflds.cfg

ACE_Options_Config_File C:\Siebel\IdCentric\<language>\aceopts.cfg

ACE_Auxiliary_Config_File C:\Siebel\IdCentric\<language>\aceaux.cfg

ACE_Input_Fields_Config_File C:\Siebel\IdCentric\<language>\aceflds.cfg
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TN.CFG 3

Change the following entries in TN.CFG.

FIRM.CFG 3

Change the following entries in FIRM.CFG.

FIRMINDV.CFG 3

Change the following entries in FIRMINDV.CFG.

Entry Change To

TN_Auxiliary_Config_File C:\Siebel\IdCentric\<language>\tnaux.cfg

TN_Input_Fields_Config_File C:\Siebel\IdCentric\<language>\tnflds.cfg

TN_Options_Config_File C:\Siebel\IdCentric\<language>\tnopts.cfg

Entry Change To

MTC_Key_Config_File C:\Siebel\IdCentric\<language>\firm_key.cfg

MTC_General_Config_File C:\Siebel\IdCentric\<language>\firm_gen.cfg

MTC_Keyfield_Config_File C:\Siebel\IdCentric\<language>\firm_fld.cfg

MTC_Auto_Options_Config_File C:\Siebel\IdCentric\<language>\auto_opt.cfg

MTC_Rule_Definition_Config_File C:\Siebel\IdCentric\<language>\firm_rul.cfg

Entry Change To

MTC_Key_Config_File C:\Siebel\IdCentric\<language>\fmin_key.cfg

MTC_General_Config_File C:\Siebel\IdCentric\<language>\fmin_gen.cfg

MTC_Keyfield_Config_File C:\Siebel\IdCentric\<language>\fmin_fld.cfg

MTC_Auto_Options_Config_File C:\Siebel\IdCentric\<language>\auto_opt.cfg

MTC_Rule_Definition_Config_File C:\Siebel\IdCentric\<language>\fmin_rul.cfg
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About Modifying the Configuration Files 3

When you install Siebel eBusiness Applications, the default Firstlogic configuration 
files are loaded into the \idCentric\<language> subdirectory under the Siebel 
installation directory.

After the installation, you can open and modify Firstlogic configuration files in order 
to alter the cleansing and matching behavior of ACE Library, TrueName Library, and 
Match Library. For example, modify the files if you want to convert all text to 
uppercase. 

Please refer to the documentation provided with the Siebel Connector for Firstlogic 
Libraries product for information about modifying configuration files.
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About Data Matching 4

Data matching, also known as deduplication, identifies possible matches for 
Account, Contact, and Prospect records based on match fields defined in Siebel 
Tools and administrator-defined matching preferences. You can perform data 
matching without data cleansing being enabled.

Siebel Data Quality Matching and Siebel Connector for Firstlogic Libraries can run 
in real-time or batch mode. Real-time mode and batch mode handle duplicates 
differently:

■ In real-time mode, users are prompted when trying to enter duplicate records. 
For more information about operating in real-time mode, see “Data Matching in 
Real-Time Mode” on page 4-8 and “Activating Data Cleansing in Real-Time 
Mode” on page 5-4.

■ In batch mode, the application identifies potentially-conflicting records and 
presents them to the system administrator for resolution. For more information 
about operating in batch mode, see “Batch Mode” on page 6-1.
4-2 Siebel Data Quality Administration Guide MidMarket Edition Version 7.0, Rev. A



Configuring and Using Data Matching

Enabling Data Matching
Enabling Data Matching 4

Enable individual component parameters such as Call Center or Sales from the 
Server Administration screen.

The parameters specified in the Server Administration screen or in the configuration 
(.cfg) files for the dedicated Web client are always checked first. Because these 
parameters are specified at the object manager level, Siebel Data Quality can be 
enabled for one application and disabled for another. You cannot enable both the 
Siebel Data Quality Matching and Siebel Connector for Firstlogic Libraries data 
matching functionality simultaneously.

Enabling Server Component Parameters 4

You can enable data matching from the Server Administration screen, as shown in 
Figure 4-1 and the following procedure.

Figure 4-1. Enabling Data Quality Matching Using the Server Administration Screen
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To enable component parameters

1 Log on to an account with administrator responsibilities. From the application-
level menu, choose View > Site Map > Server Administration > Components.

2 Select the appropriate object manager from the Server Components list, for 
example Call Center Object Manager.

3 Select the Component Parameters tab.

4 Locate the following parameters using a query and change them as indicated in 
the following table.

Parameter Value Description

Deduplication Enable Flag False

True

False is the default value.

Set to true to enable data matching for 
the application (object manager).

Deduplication Data Type SSA or
Firstlogic

Name of the data-quality matching 
vendor:

■ For Siebel Data Quality Matching, set 
to SSA.

■ For Firstlogic, set to Firstlogic.

Deduplication Type Directory varies Set this parameter according to the vendor 
you are using:

■ For Siebel Data Quality Matching, 
leave the field blank. SSA software is 
included in Siebel eBusiness 
Applications.

■ For Firstlogic, set to the path where the 
Firstlogic files are installed, such as 
C:\PW.
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Activating Siebel Data Quality Matching on the Dedicated Web Client 4

To enable Siebel Data Quality Matching on the dedicated Web client, you modify 
the appropriate application configuration file, such as siebel.cfg for Siebel Sales or 
uagent.cfg for Siebel Call Center.

The parameters used for matching are in the [DeDuplication] section of the 
configuration files:

[DeDuplication]
Enable = True
Type = SSA

In the example above, matching is set to Siebel Data Quality Matching (Type = 
SSA). You select the application you want to use for data matching at installation 
time. By default, data matching is not enabled (Enable = FALSE).

Setting Siebel Data Quality Options 4

You can set or change the Siebel Data Quality options from the Data Quality Settings 
view. The Data Quality Setting list, as seen in Figure 4-2, is visible only if you have 
a license for the Siebel Data Quality Matching product. If you are using Siebel 
Connector to Firstlogic Libraries, you will not have access to the list. If that is the 
case, you set the values from the Server Administration screen, as described in 
“Enabling Data Matching” on page 4-3.

Figure 4-2. Data Quality Options Accessed from the Application Administration Screen
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To set a Siebel Data Quality option

1 From the application-level menu, choose View > Site Map > Application 
Administration > Data Quality Setting.

2 Set the values as shown in the following table. 

NOTE: For more information about the SSA-specific values, see the SSA-Name3 
documentation in the third-party section of the Siebel Bookshelf.

Name Possible Values Description

Disable DataCleansing Y (Yes)

N (No)

Affects business components related to 
Siebel Data Quality.

Disable DeDuplication Y (Yes)

N (No)

Affects business components related to 
Siebel Data Quality.

Key Type Standard

Limited

Applicable only for Siebel Data Quality 
Matching (SSA).

Match Threshold 0-100 Applicable only for Siebel Data Quality 
Matching (SSA).

Search Type Narrow

Typical 

Exhaustive

Applicable only for Siebel Data Quality 
Matching (SSA).
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About Enabling and Disabling Without Restarting the Siebel Server 4

The Disable DataCleansing and Disable DeDuplication settings specified in the 
Application Administration screen override those specified in the Server 
Administration screen. If you have enabled them from the Server Administration 
screen, you can disable them from the Application Administration screen without 
restarting the Siebel server. After you disable them, log off and then log on to the 
application for the new settings to take effect. The settings will apply to all the 
object managers in your Siebel server, no matter whether or not they have been 
enabled in the Server Administration screen. When you are ready to enable data 
cleansing or deduplication again, reset the two fields to N and log on again. 
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Data Matching in Real-Time Mode 4

In real-time mode, Siebel Data Quality is invoked when a you save a new or 
modified record. 

■ If data cleansing is enabled, application fields are standardized prior to 
committing the record. 

■ If data matching is enabled and the new record is a potential duplicate, the 
Possible Matches dialog box appears. If you do not think the record is a 
duplicate, close the dialog box. Doing so commits the record to the database. 
Otherwise, if you think the record is a duplicate, select the best-matching record 
from the dialog box. The duplicate record will be removed from the system in 
one of the following ways:

■ If you are creating a new record, that record will not be saved. 

■ If you are modifying a record, that record will be deleted from the table.

NOTE: The Data Administration > Data Quality view is also populated with 
duplicate records.

Searching for and Resolving Duplicate Records 4

You manage duplicate records from the administration views.

The searching phase involves creating a query to find duplicate records and 
reviewing the query results. After the query results appear, you can drill down on a 
record or click the Resolution tab to view the duplicates for the record. Then, you 
specify which record should be the retained record and request that the records be 
merged. 

Merging records means that the following events take place:

■ All fields from the retained record are kept.

■ Any fields that were empty in the retained record are populated in the retained 
record by information (if any) from the appropriate fields in the records not 
retained.
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■ The children and grandchildren of the records not retained are reparented to the 
retained record.

■ Records not retained are flagged and are no longer visible to users or 
administrators, but they are not automatically deleted.

To search for a duplicate record

1 From the application-level menu, choose View >Site Map > Data 
Administration > Data Quality.

2 Click one of the following tabs:

■ Duplicate Accounts

■ Duplicate Contacts

■ Duplicate Prospects

3 Click Query, enter your search criteria, and then click Go. 

The search results appear.
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Merging Records 4

Duplicate records can be merged using the Merge button or the Merge Records 
option from the menu list. There is a difference between these two types of merging 
operations:

■ Using the Merge button. Performs a sequenced merge before performing a core 
merge. This is the preferred method.

■ Using the Merge Records option. Performs only a core merge.

When multiple records are merged, the child and grandchild records associated 
with the merged record are associated back to the surviving parent record.

The number in the Sequence field is used when you want to merge multiple records 
into one record. If one field of the master record is empty, the Merge button will 
copy the value to the master record from the other records that are going to be 
merged. 

The Sequence number prescribes the order of field values from which to select. It 
is useful if many fields are empty. For example, Sequence number 1 is the retained 
record and Sequence number 2 is the next best match and so forth. If the field in 
Record 1 is empty, then the value from Record 2 will be copied into Record 1.

The retained record is based on the last record selected, not the Sequence number 
entered. The Sequence number only indicates the sequence in which null fields 
should be populated from the losing record to the winning record.

NOTE: Merging records is a nonreversible operation. Please review all records 
carefully before initiating this function.
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Figure 4-3 shows the Duplicate Account Resolution screen.

To resolve duplicate records

1 Click the resolution tab for the type of record you have selected.

For example, if you have selected an Account record, click the Duplicate 
Accounts Resolution tab, as shown in Figure 4-3.

2 If two records appear to be duplicates, enter a sequence number in the Sequence 
field for each record.

The record selected last is retained after the merge. Missing fields in the retained 
record are populated from corresponding fields in the remaining record in 
ascending Sequence number order. 

3 Edit the records, if necessary.

4 Click Merge.

The two records are merged to produce one new record.

Figure 4-3. Duplicate Account Resolution Screen
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Data Matching at the Business Component Level 4

The data matching (deduplication) feature is disabled by default. It is enabled for 
the application through settings in the Siebel Server Administration screen or the 
corresponding Siebel application .cfg file for the dedicated Web client. After it is 
turned on at the application level, matching can be turned off for a specific business 
component by deactivating all of the child user properties (that is, by setting the 
Inactive property to TRUE). Matching cannot be turned off for individual records.

Deduplication Tokens for Siebel Connector for Firstlogic Libraries 4

Data matching using the Siebel Connector for Firstlogic Libraries detects possible 
matches to records in specified business components during record creation and 
update. The matching process begins with the deduplication token, which is an 
identifier calculated for each Account, Contact, or Prospect record in the database, 
and newly-created or modified records. Based on the value of the deduplication 
token, Siebel eBusiness Applications pass a short list of prequalified, possible 
matches between existing and new or modified records. 

The deduplication token is generated based on the following calculations:

■ Contacts. The deduplication token consists of a concatenated string of the 
cleansed five-digit ZIP Code of the account address, the first letter of the 
cleansed account name, and the first letter of the cleansed last name. 

The calculation expression is:

IfNull (Left ([Postal Code], 5), "_") + IfNull (Left 
([Account], 1), "_") + IfNull (Left ([Last Name], 1), "_")

■ Accounts. The deduplication token consists of a concatenated string of the 
cleansed five-digit ZIP code of the account address, the first letter of the cleansed 
account name, and the first nonblank, nonnumeric character of the cleansed 
street name. 

The calculation expression is:

IfNull (Left ([Postal Code], 5), "_") + IfNull (Left ([Name], 
1), "_") + IfNull (Mid ([Street Address], FindNoneOf ([Street 
Address], "1234567890 "), 1), "_")
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■ Prospects. The deduplication token consists of a concatenated string of the 
cleansed five-digit ZIP code of the account address, the first letter of the cleansed 
account name, and the first letter of the cleansed last name. 

The calculation expression is:

IfNull (Left ([Postal Code], 5), "_") + IfNull (Left ([Primary 
Account Name], 1), "_") + IfNull (Left ([Last Name], 1), "_")

Calculation expressions for deduplication tokens follow the same syntax rules as 
calculated fields.

You can change the calculation expression to adjust the filtering that generates the 
candidate set. For example, you might want a larger candidate set or one that is 
more restrictive. You might also want to add or remove a field from the expression.

To change the calculation value, modify the value in the DeDup Token Value user 
property and run data cleansing in batch mode to regenerate the token values in the 
database for existing data.

Deduplication Tokens Using Siebel Data Quality Matching 4

Siebel Data Quality Matching uses key generation and twofold matching logic to 
create and use deduplication tokens.

■ Key generation. Siebel Data Quality Matching uses multiple keys in order to detect 
duplicate records. Keys are generated based on a person’s name (First Name, 
Middle Name, Last Name) for prospects and contacts, or the account name for 
accounts.

■ Match. Match scores are based on similarities between the specified match 
fields. Different combinations of fields representing Person Name, Company 
Name, Address Line1, Address Line2, and ZIP Code are used for matching 
comparison.

The match process is twofold: 

■ First, Siebel Data Quality Matching identifies candidate matches by locating 
those records whose corresponding keys fall within a range. Like the keys, 
these ranges are based on a person’s name (First Name, Middle Name, Last 
Name) for prospects and contacts, and account name for accounts. 

■ Next, a match score is computed for each candidate record. Candidates with 
scores that exceed the specified threshold are identified as matches. 
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Business Component User Properties 4

Deduplication has a set of numbered user properties that create correspondences 
between deduplication fields and fields in business components. These field-
mapping properties have names of the form DeDuplication Field n, where n is an 
integer (for example, DeDuplication Field 7). The value consists of a pair of strings 
enclosed in double quotation marks and separated by a comma and a space for 
example: 

DataCleansing Field 1 “Last Name”, “Last Name”

The first string identifies the deduplication field name and the second string 
identifies the Siebel name.

Mapped Fields
The set of fields mapped in DeDuplication Field user properties are passed in 
records of the candidate set to the Firstlogic application. The candidate set consists 
of records with a deduplication token exactly or partially matching the calculated 
deduplication token of the record being added or modified, and therefore 
representing possible duplicates. 

Deduplication field names are different for Firstlogic and Siebel Data Quality 
Matching. 

■ Siebel Connector for Firstlogic Libraries. Uses the DeDuplication Field property in 
the default configuration. 

■ Siebel Data Quality Matching. Uses the SSA DeDuplication Field. Siebel Data 
Quality Matching first looks up the SSA DeDuplication Field. If this property is 
not specified, it looks up the DeDuplication Field.

Caution: If the configuration is not correct, data matching will not 
take place. For example, if there is not a comma and a space 
between the text strings in the Value user property, the records for 
the corresponding business component will not be deduplicated.
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Other user properties in the business component include:

■ SSA Match Purpose. This property must be included for Siebel Data Quality 
Matching.

The choices are Company_Mandatory, Company_Optional, Contact_Mandatory, 
and Contact_Optional. By default, Account is set to Company_Mandatory. 
Contact and Prospect are set to Contact_Mandatory.

■ If a value is marked mandatory, it implies that the value counts against the 
total score. 

■ Values marked Optional do not count toward the total score. 

For a more detailed explanation of this property, please refer to the SSA-NAME3 
documentation that is included in the third-party section on the Siebel Bookshelf. 

■ DeDuplication Key BusComp. This is used with Siebel Data Quality Matching. It is 
the business component for the key table. You must create it if you want to 
perform deduplication on objects other than those that come preconfigured with 
Siebel applications.

NOTE: Siebel Connector for Firstlogic Libraries has only one key, the DeDup 
Token. It is stored in the base table. 

■ DeDuplication Results BusComp. This is the business component used to populate 
results.

NOTE: You should consider the set of fields mapped to the Siebel Data Quality 
applications in standard Siebel eBusiness Applications a required minimal set. Do 
not remove these mappings.
Version 7.0, Rev. A Siebel Data Quality Administration Guide MidMarket Edition 4-15



Configuring and Using Data Matching

Data Matching at the Business Component Level
About Prospect Data
You need to configure Prospects records differently than Contact and Account 
records. The reason is that Prospects share name processing capabilities in the 
Firstlogic application with Contacts. The system assumes that Contact data (rather 
than Prospect data) is present.

In order to specify that Prospect data is being processed, you need to add the 
following two user properties:

■ DeDuplication Results BusComp. Name of the business component that will hold 
the returned data, typically DeDuplication Results (Prospect). This user property 
is a child of the business component being processed.

■ DeDuplication Results Applet. Name of the dialog box that is to be used to prompt 
the user to resolve duplicates, typically the DeDuplication Results (Prospect) list 
applet. This user property is a child of the applet from which deduplication is 
invoked.

Configuring the DeDuplication Results Applet 4

Each business component that uses deduplication has a results business 
component. The business component name is DeDuplication Results (xxx), where 
xxx identifies the type of data being validated. For example, DeDuplication Results 
(Account) is the name of the results business component for account data. 

Both real-time and batch results are stored in the Results business component. But, 
the real-time results are a subset that the real-time dialog box isolates based on a 
column—called DEDUP_REQ_ID—that holds the deduplication request ID.

The dialog box is configurable in Siebel Tools, and has the name DeDuplication 
Results (xxx) list applet, where xxx is the Account, Contact, or Prospect. Additional 
columns from the S_DEDUP_RESULT table can be exposed as fields in the 
DeDuplication Results (xxx) business component and as list columns in the 
DeDuplication Results (xxx) list applet. However, you only need to modify the 
dialog box if you are changing the default configuration of Siebel Data Quality. The 
DeDuplication Results (xxxx) business component must be added to a business 
object yyyy if you want to add duplicate business component xxxx in a view based 
on business object yyyy.
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The process of configuring business components follows these steps:

1 Add extension tables to a Business Component object.

2 With Account and Contact, add S_ORG_EXT_X or S_CONTACT_X.

3 Set the Outer Join Flag to True in order for the Possible Matches dialog box to 
populate correctly.

NOTE: For example, go to the DeDuplication Results (Account) business 
component and open the Join folder. For the S_ORG_EXT_X table, put a check 
in the Outer Join Flag column. 

4 Recompile. 

Configuring Business Components and Fields 4

In standard Siebel eBusiness Applications, only four business components have 
data cleansing and deduplication enabled: Account, Business Address (cleansing 
only), Contact, and List Mgmt Prospective Contact.

If you insert records through noncleansed, nondeduplicated business components, 
the data is left dirty. Data will be cleansed and deduplicated during batch cleansing 
and deduplication only if the data can be seen through one of the business 
components above. You do not need to enable Data Quality on a business 
component if you do not permit inserting or updating through the business 
component.
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Specialized Deduplication Fields
Business components have certain fields with specialized deduplication purposes. 
These fields are:

■ DeDup Token (Firstlogic only). Text field that represents the DEDUP_TOKEN 
column in the base table. 

This field stores the calculated dedup token value for each record in the business 
component. It is required, but it is not exposed in the user interface. If you need 
to add this field’s functionality to another business component, use or create an 
extension column.

■ Deduplication Match Score. An integer field whose value is obtained from the 
TOT_SCORE_VAL column in the S_DEDUP_RESULT table through a join to that 
table on the duplicate object ID.

This field is represented in the user interface as the Match Score list column. 
S_DEDUP_RESULT passes the results of evaluation of the candidate set back to 
Siebel applications from the Siebel Data Quality Matching or Firstlogic 
application. TOT_SCORE_VAL indicates the closeness of the match between the 
master account record and the detail record in which the value is stored. This 
field is not required and is used only for the presentation of batch results.

■ Deduplication Object ID. Row ID field that functions as a foreign key to the master 
duplicate record in the same business component. It represents the OBJ_ID 
column in the S_DEDUP_RESULT table and is obtained through the same join as 
Deduplication Match Score. 

This field is not exposed in the user interface and is not required; it is used only 
for the presentation of batch results.

Obsolete Records
Using the Merge button does not remove obsolete records in the S_DEDUP_RESULT 
table. Periodically, you need to do this manually using an SQL script that deletes 
records where the Object ID or the duplicate Object ID are not in the Accounts, 
Contacts, or Prospects tables or in a configured business component. 
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New Fields
New fields included in Siebel Data Quality in Siebel 7 include:

■ DeDup Key Modification Date. Populated when keys are generated. Used by Siebel 
Data Quality Matching only.

■ DeDup Last Match Date. Populated when deduplication is run on a record. Used 
by Siebel Data Matching only

■ Last Cleanse Date. Populated when cleansing is run on a record. This field is not 
available for Business Address.

■ Last Update - SDQ. Used for Siebel Data Quality Matching only. 

When running Key Refresh, this field on the record is compared with the DeDup 
Key Modification Date. If it is not specified (default case) the Update column on 
the base table is used. For contact and account, the last update of S_CONTACT 
and S_ORG_EXT respectively are looked at.

NOTE: The DeDup Keys field is not used in Siebel 7.
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User Properties Used in Data Matching 4

The user properties described in this section are used for data matching for 
Account, Contact, and Prospect by both Siebel Data Quality Matching and Siebel 
Connector for Firstlogic Libraries. Names beginning with SSA (for example, SSA 
DeDuplication Field 6) are used by Siebel Data Quality Matching. Names not 
beginning with SSA (for example, DeDuplication Field 1) are used by Siebel 
Connector for Firstlogic Libraries.

Table 4-1 describes fields for data matching for Account records.

Table 4-1. Fields Used in Data Matching for Account Records (1 of 2)

Name Value

DeDup Token Value IfNull (Left ([PostalCode], 5), "_") + IfNull (Left ([Name], 1), "_") + 
IfNull (Mid ([Street Address], FindNoneOf ([Street Address], 
"1234567890"), 1), "_")

DeDuplication CFG File firm.cfg

DeDuplication Field 1 "Firm Name", "Name"

DeDuplication Field 2 "Firm Location", "Location"

DeDuplication Field 3 "Street Address", "Street Address"

DeDuplication Field 4 "City", "City"

DeDuplication Field 5 "State", "State"

DeDuplication Field 6 "Zip 10", "Postal Code"

DeDuplication Field 7 "Country", "Country"

DeDuplication Key BusComp DeDuplication - SSA Account Key

DeDuplication Results BusComp DeDuplication Results (Account)

SSA DeDuplication Field 1 "C", "Name"

SSA DeDuplication Field 2 "Country", "Country"

SSA DeDuplication Field 3 "City", "City"

SSA DeDuplication Field 4 "State", "State"
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Table 4-2 lists and describes fields used in data matching for Contact records.

SSA DeDuplication Field 5 "Z", “Postal Code”

SSA DeDuplication Field 6 "I", "DUNS Number"

SSA DeDuplication Field 7 "A", "Street Address"

Table 4-1. Fields Used in Data Matching for Account Records (2 of 2)

Name Value

Table 4-2. Fields Used in Data Matching for Contact Records (1 of 2)

Name Value

DeDup Token Value IfNull (Left ([PostalCode], 5), "_") + IfNull (Left ([Account], 1), "_") + 
IfNull (Left ([Last Name], 1), "_")

DeDuplication Field 1 "Last Name", "Last Name"

DeDuplication Field 10 "Country", "Country"

DeDuplication Field 2 "First Name", "First Name"

DeDuplication Field 3 "Middle Name", "Middle Name"

DeDuplication Field 4 "Firm Name", "Account"

DeDuplication Field 5 "Firm Location", "Firm Location"

DeDuplication Field 6 "Street Address", "Street Address"

DeDuplication Field 7 "City", "City"

DeDuplication Field 8 “State”, “State"

DeDuplication Field 9 "Zip 10”, "Postal Code"

DeDuplication Key BusComp DeDuplication - SSA Contact Key

DeDuplication Last Update Field Last Update - SDQ

DeDuplication Results BusComp DeDuplication Results (Contact)

SSA DeDuplication Field 1 "Z", "Postal Code"

SSA DeDuplication Field 10 "First", "First Name"
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Table 4-3 lists and describes fields used in data matching for Prospect records.

SSA DeDuplication Field 11 "Middle", "Middle Name"

SSA DeDuplication Field 12 "City", "City"

SSA DeDuplication Field 13 "State", "State”

SSA DeDuplication Field 14 "Country", "Country"

SSA DeDuplication Field 2 "T", “Work Phone #”

SSA DeDuplication Field 3 “T”, “Cellular Phone #”

SSA DeDuplication Field 4 "I", "Social Security Number"

SSA DeDuplication Field 5 “E”, “Email Address"

SSA DeDuplication Field 6 "A", "Street Address"

SSA DeDuplication Field 7 "T", "Home Phone #"

SSA DeDuplication Field 8 "C", "Account"

SSA DeDuplication Field 9 "Last", "Last Name"

Table 4-2. Fields Used in Data Matching for Contact Records (2 of 2)

Name Value

Table 4-3. Fields Used in Data Matching for Prospect Records (1 of 2)

Name Value

DeDup Token Value IfNull (Left ([PostalCode], 5), "_") + IfNull (Left ([Account], 1), "_") + 
IfNull (Left ([Last Name], 1), "_")

DeDuplication Field 1 "Last Name", "Last Name"

DeDuplication Field 10 "Address.Country", "Country"

DeDuplication Field 2 "First Name", "Account"

DeDuplication Field 3 "Middle Name", "Middle Name"

DeDuplication Field 4 "Firm Name”" "Account"

DeDuplication Field 5 "Firm Location", "Primary Account Location"
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DeDuplication Field 6 "Address.Street Address", "Street Address"

DeDuplication Field 7 "Address.City", "City"

DeDuplication Field 8 "Address.State", "State"

DeDuplication Field 9 "Address.Zip10", "Postal Code"

DeDuplication Key BusComp DeDuplication - SSA Prospect Key

DeDuplication Results BusComp DeDuplication Results (Prospect)

SSA DeDuplication Field 1 "Last", "Last Name"

SSA DeDuplication Field 10 "T", "Work Phone #"

SSA DeDuplication Field 11 "T", "Cellular Phone #"

SSA DeDuplication Field 12 "I" "Social Security Number"

SSA DeDuplication Field 13 "E", "Email Address"

SSA DeDuplication Field 14 "T", "Home Phone #"

SSA DeDuplication Field 2 "First", "First Name"

SSA DeDuplication Field 3 "Middle", "Middle Name"

SSA DeDuplication Field 4 "C", "Account"

SSA DeDuplication Field 5 "A", "Street Address"

SSA DeDuplication Field 6 "City", "City"

SSA DeDuplication Field 7 "State", "State"

SSA DeDuplication Field 8 "Z", "Postal Code"

SSA DeDuplication Field 9 "Country", "Country"

Table 4-3. Fields Used in Data Matching for Prospect Records (2 of 2)

Name Value
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Operational Requirements 4

This section presents operational recommendations for table size, DB2 database 
parameter optimization, server tasks, deduplication, and key generation processing. 

Batch deduplication is a long process. The recommendations in this section will 
help you optimize deduplication.

NOTE: Most of the recommendations in this section are designed for users of SSA.

Table Size 4

The deduplication process generates many records. Follow the recommendations in 
Table 4-4 when allocating space for the SIEBEL_4K table space.

Table 4-4. Table Size Recommendations

Table Sizing Recommendation

S_PER_DEDUP_KEY,

S_ORG_DEDUP_KEY

S_PRSP_DEDUP_KEY

These tables may contain between two and six times more 
records than their corresponding base tables, depending on 
the key type used during the key generation stage:

■ Limited key type. May contain between two and four 
times more records than the corresponding base table.

■ Standard key type. May contain up to six times more 
records than the corresponding base table. This is a 
conservative estimate.

S_DEDUP_RESULT This table may contain between five and six times the 
number of records in the three base tables combined. Use the 
following guidelines to help determine table size:

■ If the base tables contain many deduplicate records, more 
records will be inserted into the results table.

■ If a Search Type of Typical or Exhaustive is used, more 
records will be inserted into the results table.

■ If a low match threshold—such as a threshold in the 
lower 100 range—is used, the matching process generates 
a larger number of records to be inserted into the results 
table.
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DB2 Database Parameter Optimization 4

After key generation, run the DB2 REORGCHK utility to check if the *_DEDUP_KEY 
tables need to be reorganized. Check the cluster ratio in the F4 column. If it is less 
than 94% for the M1 index, use the DB2 REORG utility to reorganize the 
*_DEDUP_KEY tables based on the M1 index.

If performance seems degraded, use the run_status utility to update statistics on the 
following tables:

■ S_PER_DEDUP_KEY

■ S_ORG_DEDUP_KEY

■ S_ORG_DEDUP_KEY

■ S_DEDUP_RESULT

Server Tasks 4

Execute concurrent Data Quality Manager server tasks to deduplicate the data. 
Query the base tables to find the search specifications such that each query result 
set contains the preferred number of records, between 50,000 and 75,000 per server 
task. Start concurrent server tasks using these search specifications and continue 
the deduplication operation until the entire table is completely processed.
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Ongoing Deduplication and Key Generation Operations 4

The key generation and deduplication timestamp fields, DeDup Key Modification 
Date and DeDup Last Match Date, respectively, are updated when key generation or 
deduplication is performed on a record. Use these fields in the search specification 
to filter records with up-to-date keys and matches. 

For users who have over 100,000 records in their base tables, it can be very time 
consuming to reprocess all the records. For that reason, the recommended record 
set for subsequent deduplication and key generation runs consists of outdated and 
new records only. Outdated records are those records that have been modified since 
they were tagged. In SQL terms, outdated records are those in which [Updated] > 
(DQ tag).

The examples in Table 4-5 illustrate search specifications—the Object Where 
clause—to use when running key generation or deduplication using the Contact 
business component.

Table 4-5. Sample Search Specifications for Key Generation and Deduplication Runs

To Query For... Key Generation Example Deduplication Example

Updated records ([DeDup Key Modification 
Date]<[Updated])

([DeDup Last Match 
Date]<[Updated])

New records ([DeDup Key Modification 
Date]IS NULL)

([DeDup Last Match 
Date] IS NULL)

Updated and new 
records

([DeDup Key Modification 
Date]<[Updated]) OR 
([DeDup Key Modification 
Date]IS NULL)

(([DeDup Last Match 
Date]<[Updated]) OR 
([DeDup Last Match 
Date] IS NULL))
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Performance Considerations 4

This section presents some general suggestions for improving performance and the 
use of an option to improve batch performance, as summarized in Table 4-6.

Table 4-6. Performance Improvement Suggestions (1 of 2)

Element Comments

General settings on the 
Application Administration Screen

From the application-level menu, choose View > 
Site Map >Application Administration > Data 
Quality Setting to set the following parameters.

■ Key type (key generation). Set to Limited.

■ Search type (deduplication). Set to Narrow.

■ Match threshold (deduplication). Set to a 
number greater than or equal to 75. The higher 
the threshold, the faster the Deduplication 
process runs.

Object Sort clause Set this parameter based on the key generation 
parameters for deduplication. For example, use:

■ Person (contact or prospect). ‘Use Last Name, 
First Name, Middle Name”.

■ Company (account). Use “Name” or “Name, 
Location”.
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Data quality Delete parameter Use this parameter to clear the results table, 
S_DEDUP_RESULT, of any records that correspond to 
the records that will be processed by the search 
specification logic. During a deduplication run, the 
results table must not contain records generated in 
previous runs. For example, to deduplicate contacts 
whose last names start with A, the results table 
cannot contain any records generated during 
previous runs with last names that start with A. 

From the application-level menu, choose View > 
Site Map >Application Administration > Data 
Quality Setting to set the Delete parameter. For more 
information, see “Performance and the Data Quality 
Setting Parameter” on page 4-29.

Batch business components Use the batch business components for Accounts 
and Contacts. You may need to configure them if you 
need to use other fields in the Object Where clause:

■ Contact. Business object is DeDuplication, 
business component is Contact (SDQ Batch)

■ Account. Business object is DeDuplication, 
business component is Account (SDQ Batch)

Table 4-6. Performance Improvement Suggestions (2 of 2)

Element Comments
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Performance and the Data Quality Setting Parameter 4

Setting the Data Quality Setting (DQSetting) parameter to Delete can improve the 
performance of batch deduplication and key generation processing. 

Before populating either the results table (deduplication) or the key table (key 
generation) with new data, you need to delete the existing keys. Although the 
application can do this automatically, it is time-consuming. An administrator who 
is an expert user of SQL may choose to use the Delete option of the DQSetting 
parameter to delete the data prior to running the task. 

Caution: Do not attempt to use the Delete option if you are not an 
expert user of SQL.
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Enabling Data Cleansing 5

The Siebel Connector for Firstlogic Libraries is disabled by default. You can enable 
it from the Server Administration screen or on the dedicated Web client. You can 
enable data cleansing from the Server Administration screen, as shown in Figure 5-1 
and discussed in the following procedure.

To enable data cleansing

1 From the application-level menu, choose View > Site Map > Server 
Administration > Components.

2 Select the appropriate object manager from the Server Component list for 
example, the Call Center Object Manager.

Figure 5-1. Enabling Data Cleansing Using the Server Administration Screen
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3 Select the Component Parameters tab.

4 Locate the following parameters using a query and change them as indicated.

Activating Siebel Data Cleansing on the Dedicated Web Client 5

To enable data cleansing using the Siebel Connector for Firstlogic Libraries on the 
dedicated Web client, you modify the appropriate application configuration file. The 
configuration files for two of the key Siebel eBusiness Applications are:

■ siebel.cfg (Siebel Sales)

■ uagent.cfg (Siebel Call Center)

The parameters used for matching are in the [DataCleansing] section of the 
configuration files:

[DataCleansing]
Enable = True
Type = Firstlogic
Dir = C:\PW

NOTE: The directory specification in the preceding example is for Windows NT or 
Windows 2000. 

Parameter Value Description

Data Cleansing Enable Flag True

False

Set to true to enable data 
cleansing for the application 
(object manager).

Data Cleansing Type FirstLogic Name of the data cleansing 
vendor.

Data Cleansing Directory <directory name> Set this parameter to the location 
of the Firstlogic installation.
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Activating Data Cleansing in Real-Time Mode 5

In real-time mode, data cleansing is triggered when you step off the record after you 
have updated a field that has been defined as an active DataCleansing Field. An 
example of an active DataCleansing Field for the Contact business component is 
Last Name. Modifying an inactive field does not trigger data cleansing. For more 
information about business components, see “Data Cleansing at the Business 
Component Level” on page 5-6.

Troubleshooting
If data cleansing does not appear to be working in real-time mode, check the 
following areas.

■ License key. Verify that the license key includes data quality.

■ Configuration file. Verify that data cleansing has been designated. For more 
information, see “To enable data cleansing” on page 5-2.

If you have configured a business component for data cleansing, also check the 
following:

■ Business component Class property. Verify that the business component Class 
property is CSSBCBase.

■ DataCleansing Type. Verify that the DataCleansing Type has been set correctly.

■ User Properties. Verify that the DataCleansing Field has the correct User Property 
value and that the value is formatted correctly. For example, there must be a 
space after a comma in user properties that have a compound value. For more 
information, see Table 5-1 on page 5-6.
5-4 Siebel Data Quality Administration Guide MidMarket Edition Version 7.0, Rev. A



Configuring and Using Data Cleansing

Enabling Data Cleansing
Undoing and Disabling Data Cleansing
You can undo and disable cleansing on a record-by-record basis. You can turn data 
cleansing off for specific records by checking the column labeled Disable Data 
Cleansing in various list and multivalue group applets. You can add a Disable 
Cleansing column to other list and multivalue group applets.

To undo changes made during cleansing in real-time

■ Before the record is saved, choose Edit > Undo.

To prevent a record from being cleansed in real-time or batch mode

1 Navigate to and select the record.

2 Check the Disable Cleansing check box.
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Data Cleansing at the Business Component Level 5

You can configure data cleansing for any business component whose purpose is to 
hold name, address, or company (account) information. The following data is 
configured for data cleansing:

■ Name and Location for accounts

■ First Name, Middle Name, Last Name, and Job Title for contacts and prospects

■ Street Address, City, State, and Postal Code for business address records 

Business Component User Properties 5

Data cleansing is configured in two kinds of business component user properties:

■ DataCleansing Field 

■ DataCleansing Type 

One DataCleansing Type user property and one or more DataCleansing Field user 
properties are required.

Business Component user properties are child object definitions of the business 
component. Each has a Name property, which specifies the user property to be set, 
and a Value property, which specifies the value for the user property. Table 5-1 
shows the set of child Contact Business Component User Property object definitions 
that are used for data cleansing configuration.

Table 5-1. Contact User Properties for Data Cleansing

User Property Name User Property Value

DataCleansing Field 1 "Last Name", "Last Name"

DataCleansing Field 2 "First Name", "First Name"

DataCleansing Field 3 "Middle Name", "Middle Name"

DataCleansing Field 4 "Professional Title", "Job Title"

DataCleansing Type Contact
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DataCleansing Type 5

The DataCleansing Type user property is required. It specifies to Siebel Connector 
for Firstlogic Libraries what kind of data is being validated. It has one of the 
following values:

■ Contact. Indicates that the data consists of person name records.

■ Account. Indicates that it consists of business or office name records.

■ Address. Indicates that it consists of postal addresses. 

Data cleansing operates differently on each of these types. For example, business 
components with Address cleansing have reconciliation performed between address 
fields and the ZIP (Postal Code) field. All values have capitalization validated.

DataCleansing Field 5

Each DataCleansing Field n property specifies a correspondence between a field 
name in the Firstlogic application and a field name in a Siebel application. The 
Value property consists of a pair of text strings. They are separated by a comma and 
a space. Each string is enclosed in double quotation marks.

You can add or remove data cleansing functionality for new and existing fields by 
setting DataCleansing Field user properties.

Caution: If the configuration is not correct, data cleansing will not 
take place. For example, if there is not a comma and a space 
between the text strings in the Value user property, or if 
DataCleansing Type was not defined, the records for the 
corresponding business component will not be cleansed.
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About Batch Mode 6

Batch mode lets you process a large number of records at one time. You can run 
batch mode jobs as standalone tasks or schedule them on a recurring basis. You can 
run both data cleansing and data matching in batch mode.

■ Batch data cleansing. Use batch data cleansing to standardize and correct a group 
of accounts, contacts, prospects, or business addresses. 

■ Batch data matching. In batch mode, the application identifies potentially-
conflicting records and presents them to the system administrator for resolution.

If you run data cleansing on a record twice, sometimes it will change the second 
time. However, cleansing the entire database each time can cause performance 
issues. For that reason, it is recommended that only new or recently-modified 
records be included in the batch data cleansing process. These records can be 
identified using SQL Object Where clauses like the sample ones in Table 4-5 on 
page 4-26. The same rule applies to data matching. For more information about 
general performance considerations, see “Ongoing Deduplication and Key 
Generation Operations” on page 4-26.

Running data cleansing and data matching in batch mode requires the use of a 
separate server process called Siebel Data Quality Manager. You initiate batch data 
cleansing or data matching by starting a new server task, as described in 
“Submitting a Server Request” on page 6-9. 

Caution: Do not put VB logic in any business components that are 
being used for batch mode tasks. These tasks execute in the 
background and may not trigger any logic that activates user 
interface features, such as pop-up message boxes.
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Customized Request Components 6

Data quality components allow you to preset Siebel Data Quality Manager 
parameters, rather than setting them each time you run the task. Table 6-1 lists the 
components and their parameters. After you customize a component, it is saved 
with the correct parameters for the task.

The process of creating a customized component is as follows:

■ Verify that the Data Quality Manager component is enabled.

■ Create the new components.

■ Activate the new components.

Table 6-1. Siebel Data Quality Manager Components

Component Name Business Component Name Business Object Name Operation Type

Account Data Cleansing Account Account Data cleansing

Account DeDuplication Account Account Matching 
(deduplication)

Contact Data Cleansing Contact Contact Data cleansing

Contact DeDuplication Contact Contact Matching 
(deduplication)

Prospect Data Cleansing List Mgmt Prospective Contact List Mgmt Data cleansing

Prospect DeDuplication List Mgmt Prospective Contact List Mgmt Matching 
(deduplication)

1Address Data Cleansing Business Address Business Address Data cleansing

1. Data matching is not available for addresses.
Version 7.0, Rev. A Siebel Data Quality Administration Guide MidMarket Edition 6-3



Batch Mode

Customized Request Components
Checking the Data Quality Manager Component 6

Before you can customize a component, you must verify that the Data Quality 
Manager component has been enabled.

To verify that Data Quality Manager is enabled

1 From the application-level menu, choose View > Site Map > Server 
Administration > Enterprise Operations.

2 Click the Component Requests tab.

3 In the form, click the Component/Job field, create a query to locate data Quality 
Manager, and verify that it has been enabled.

If you need to enable the server component, see “Starting Siebel Data Quality 
Manager Server Component” on page 6-12 for instructions.
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Creating New Request Components 6

To create a customized component, you create a component record and modify the 
parameters associated with it, as noted in Table 6-2. Note that you are not creating 
new parameters, but modifying the values of existing ones. 

Table 6-2. Component Request Parameter Values (1 of 2)

Parameter Name Description

Buscomp Name Required.

Name of the business component.

Values are: 

■ Account

■ Contact

■ List Mgmt Prospective Contact

■ Business Address

Business Object Name Required.

Name of the business object with which the business component 
is associated.

Values are: 

■ Account

■ Contact

■ List Mgmt 

■ Business Address

Object Sorting Clause Optional.

Used during matching to identify a specific deduplication token.
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To create a customized request component

1 From the application-level menu, choose View > Site Map >Server 
Administration > Enterprise Configuration.

2 Click the Component Definitions tab, add a new component, and enter the 
following values in the component definition fields:

3 Save the record.

Object Where Clause Optional.

Searched by fields that exist in the specified business component.

Example: Disable DataCleansing = N or Disable DataCleansing IS 
NULL

Operation Type Required.

Type of operation to be performed.

Values are:

■ Data Cleansing

■ DeDuplication

■ Key Generate

■ Key Refresh

Table 6-2. Component Request Parameter Values (2 of 2)

Parameter Name Description

Component Definition Value

Request Component Name Select a name for the component, such as Account 
Data Cleansing.

Component Type Dqmgr

Component Group Data Quality

Alias Alias that corresponds with the business component 
name.
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4 In the lower Component Definitions tab, query to locate the Buscomp Name and 
Business Object Name parameters, and change their values as described in 
Table 6-2 on page 6-6.

5 In the lower Component Definitions tab, query to locate the Operation Type and 
change its value as described in Table 6-2 on page 6-6.

6 Click the Component Definitions menu in the upper form and select Enable 
Component Definition. 

Activating New Components 6

After you have created all the request components, you need to activate them.

To activate new request components

1 Restart the server.

2 From the application-level menu, choose View > Site Map > Server 
Administration > Enterprise Configuration.

3 On the Batch Component tab, click Synchronize.
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You can start a batch process from the Server Administration screen or the 
command line.

To start a server request from the Server Administration screen

1 From the application-level menu, choose View > Site Map > Server 
Administration >Enterprise Operations.

2 Click the Component Request tab and then select Submit Request from the 
Comp Reqs menu, as shown in the following figure.
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To run Siebel Data Quality Manager from the command line

1 From the /bin directory on the Siebel Server machine, type the following:

srvrmgr /g <gateway server name> /e <enterprise server name> /
u <username> /p <password> /s <Siebel server name> /l 
<language, ENU for English>

2 Type the following for each batch mode operation:

run task for comp DQMgr with BCName = <Buscomp Name>, BobjName 
= <Business Object Name>, OpType = <Operation Type>, 
ObjWhereClause = <Object Where Clause>, ObjSortClause = <Object 
Sorting Clause>

For example:

run task for comp DQMgr with 
BCName="Account",BObjName="Account",OpType="Data Cleansing"
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To check the status of the request

1 From the application-level menu, choose View > Site Map > Server 
Administration > Server.

2 Select Siebel Server from the Show drop-down list and click the Server Tasks tab.

The status of the server tasks displays in the Status column, as seen in the 
following figure.

Figure 6-1. Checking the Status of Server Tasks
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Starting Siebel Data Quality Manager Server Component 6

After the components are created, you need to start the Siebel Data Quality Manager 
server component. 

Starting the server component

1 From the application-level menu, choose View > Site Map > Server 
Administration > Servers.

2 In the Siebel Servers applet, verify that the Siebel Server is running.

3 In the Server Component Groups applet, query for the Data Quality Component 
Group.

4 If the Run state of the group is Shutdown, click Startup to start the Data Quality 
Component Group.

Caution: You must log in with an administrator ID—such as 
SADMIN—to enable the data-cleansing server task. 
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Data Cleansing Parameters for Siebel Connector for 
Firstlogic Libraries 6

To cleanse data with Siebel Connector for Firstlogic Libraries, add the following four 
parameters:

■ Account data cleansing (alias DqMgrAcctDClns)

■ Contact data cleansing (alias DqMgrContDCIns)

■ Prospect data cleansing (alias (DqMgrPrspDClns)

■ Address data cleansing (alias DqMgrAddrDClns)

Component Parameters for Account Data Cleansing 6

The component parameters for account data cleansing and their values are listed in 
Table 6-3.

Table 6-3. Component Parameters for Account Data Cleansing

Component Parameter Value

Buscomp Name Account

Business Object Name Account

Object Sorting Clause

Object Where Clause Disable DataCleansing = N

or

Disable DataCleansing IS NULL

Operation Type Data Cleansing
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Component Parameters for Contact Data Cleansing 6

The component parameters for contact data cleansing and their values are listed in 
Table 6-4.

Component Parameters for Prospect Data Cleansing 6

The component parameters for prospect data cleansing and their values are listed 
in Table 6-5.

Table 6-4. Component Parameters for Contact Data Cleansing

Component Parameter Value

Buscomp Name Contact

Business Object Name Contact

Object Sorting Clause

Object Where Clause Disable DataCleansing = N

or

Disable DataCleansing IS NULL

Operation Type Data Cleansing

Table 6-5. Component Parameters for Prospect Data Cleansing

Component Parameter Value

Buscomp Name List Mgmt Prospective Contact

Business Object Name List Mgmt

Object Sorting Clause

Object Where Clause Disable DataCleansing = N

or

Disable DataCleansing IS NULL

Operation Type Data Cleansing
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Component Parameters for Address Data Cleansing 6

The component parameters for address data cleansing and their values are listed in 
Table 6-6.

Table 6-6. Component Parameters for Address Data Cleansing

Component Parameter Value

Buscomp Name Business Address

Business Object Name Business Address

Object Sorting Clause

Object Where Clause Disable DataCleansing = N

or

Disable DataCleansing IS NULL

Operation Type Data Cleansing
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Data Matching Parameters for Siebel Data Quality 
Matching 6

If you are using Siebel Data Quality Matching, you need to add these components:

■ Key generation:

■ Account key generation (alias DqMgrAcctKGen)

■ Contact key generation (alias DqMgrContKGen)

■ Prospect key generation (alias DqMgrPrspKGen)

■ Key refresh:

■ Account key refresh (alias DqMgrAcctKRef)

■ Contact key refresh (alias DqMgrContKRef)

■ Prospect key refresh (alias DqMgrPrspKRef)

These components are not used with Siebel Connector for Firstlogic Libraries.

Use the information in the following tables to specify these components, depending 
on the business object against which you want to run Siebel Data Quality Matching. 
Notice that the value of the Object Where Clause is blank. The reason is that it is a 
search specification whose value will vary. The following sample Object Where 
Clause value processes only those records with a value in the Last Name field that 
begins with an A, B, or C:

[Last Name] >= ‘A’ and [Last Name] <= ‘C’.
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Component Parameters for Account Key Generation 6

The component parameters for account key generation and their values are listed in 
Table 6-7.

Component Parameters for Contact Key Generation 6

The component parameters for contact key generation and their values are listed in 
Table 6-8.

Table 6-7. Component Parameters for Account Key Generation

Component Parameter Value

Buscomp Name Account

Business Object Name Account

Object Sorting Clause

Object Where Clause

Operation Type Key Generate

Table 6-8. Component Parameters for Contact Key Generation

Component Parameter Value

Buscomp Name Contact

Business Object Name Contact

Object Sorting Clause

Object Where Clause

Operation Type Key Generate
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Component Parameters for Prospect Key Generation 6

The component parameters for prospect key generation and their values are listed 
in Table 6-9.

Component Parameters for Account Key Refresh 6

The component parameters for account key refresh and their values are listed in 
Table 6-10.

Table 6-9. Component Parameters for Prospect Key Generation

Component Parameter Value

Buscomp Name List Mgmt Prospective Contact

Business Object Name List Mgmt

Object Sorting Clause

Object Where Clause

Operation Type Key Generate

Table 6-10. Component Parameters for Account Key Refresh

Component Parameter Value

Buscomp Name Account

Business Object Name Account

Object Sorting Clause

Object Where Clause

Operation Type Key Refresh
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Component Parameters for Contact Key Refresh 6

The component parameters for contact key refresh and their values are listed in 
Table 6-11.

Component Parameters for Prospect Key Refresh 6

The component parameters for prospect key refresh and their values are listed in 
Table 6-12.

Table 6-11. Component Parameters for Contact Key Refresh

Component Parameter Value

Buscomp Name Contact

Business Object Name Contact

Object Sorting Clause

Object Where Clause

Operation Type Key Refresh

Table 6-12. Component Parameters for Prospect Key Refresh

Component Parameter Value

Buscomp Name List Mgmt Prospective Contact

Business Object Name List Mgmt

Object Sorting Clause

Object Where Clause

Operation Type Key Refresh
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Additional Parameters for Data Matching 6

The following parameters for matching apply to both Siebel Connector for Firstlogic 
Libraries and Siebel Data Quality Matching:

■ Account DeDuplication (alias DqMgrAcctDDup)

■ Contact DeDuplication (alias DqMgrContDDup)

■ Prospect DeDuplication (alias DqMgrPrspDDup)

Component Parameters for Account DeDuplication 6

The component parameters for account deduplication and their values are listed in 
Table 6-13.

Table 6-13. Component Parameters for Account DeDuplication

Component Parameter Value

Buscomp Name Account

Business Object Name Account

Object Sorting Clause DeDup Token (for Siebel Connector for Firstlogic Libraries)

Object Where Clause

Operation Type DeDuplication or Cleansing

(This parameter is required. If it is missing, the server task will 
exit with an error.)
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Component Parameters for Contact DeDuplication 6

The component parameters for contact deduplication and their values are listed in 
Table 6-14.

Component Parameters for Prospect DeDuplication 6

The component parameters for prospect deduplication and their values are listed in 
Table 6-15.

Table 6-14. Component Parameters for Contact DeDuplication

Component Parameter Value

Buscomp Name Contact

Business Object Name Contact

Object Sorting Clause DeDup Token (for Siebel Connector for Firstlogic Libraries)

Object Where Clause

Operation Type DeDuplication or Cleansing

(This parameter is required. If it is missing, the server task will 
exit with an error.)

Table 6-15. Component Parameters for Prospect DeDuplication

Component Parameter Value

Buscomp Name Contact

Business Object Name Account

Object Sorting Clause DeDup Token (for Siebel Connector for Firstlogic Libraries)

Object Where Clause

Operation Type DeDuplication or Cleansing

(This parameter is required. If it is missing, the server task will 
exit with an error.)
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Conflict_IDs 6

Conflict_ID is a system field. It is part of the user key fields, fields that uniquely 
identify a record. For example, user key fields for an account record are Account 
Name, Account Location, and Account Organization. If two account records have 
the same values for these fields, it generates a User Key violation. Before running 
batch data cleansing, all the records in the database have different keys, although 
the difference between two records may be very slight, such as two records having 
ABC Corporation and ABC Corp respectively for Account Name.

Batch data cleansing corrects records and commits them to the database. However, 
if there is a potential of duplicate records, such as those in the ABC Corp example, 
the batch data cleansing process updates a hidden Conflict_ID field with the 
Row_ID of the record. Because this field is part of the user key fields, the record now 
has a unique key and can be committed to the database. Later, you can run batch 
data matching to catch and resolve these duplicate records. Using the Conflict_ID 
as part of the user key prevents a User Key violation.
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configuring 4-16
process overview, Siebel Connector for 
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prospect data, special 

requirements 4-16
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component parameters for 

prospects 6-17
Contact component parameters 6-16
ongoing operations 4-26
prospect component parameters 6-17
recommended record set 4-26

required components, Siebel Data Quality 
Matching 6-15

role in data matching 4-13
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